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INTRODUCTION
Mastercam’s DynamicMotion toolpaths deliver powerful benefits that help you get the most out of any machine.

These 2D and 3D high speed dynamicmilling toolpaths utilize the entire flute length of their cutting tools to achieve
great efficiency inmilling. They are designed tomaximize material removal while minimizing tool wear.

Additional benefits you gain by using high speed dynamicmilling toolpaths include:

l Tool burial avoidance

l Minimumheat buildup

l Better chip evacuation

l Extended tool life

This tutorial introduces you to Mastercam's intelligent, application-specific, 2D and 3D high-speed dynamicmilling
toolpaths.

Tutorial Goals

l Learn the benefits and uses of the dynamic toolpath types

l Create basic dynamic toolpaths

l Create stockmodels

l Learn to use other Mastercam toolpath utilities

Note: Youmust have a 3D license to complete the Dynamic OptiRough chapter.

WARNING: Screen colors in the tutorial pictures were modified to enhance image quality; they may not
match your Mastercam settings or the tutorial results. These color differences do not affect the lesson or
your results.

Mastercam Dynamic Milling Tutorial—Introduction



Estimated time to complete this tutorial: 5 hours

General Tutorial Requirements
All Mastercam2019 tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operation system.

l The tutorials cannot be used withMastercamDemo/Home Learning Edition. The Demo/HLE file format
(emcam) is different fromMastercam (mcam), and basicMastercam functions, such as file conversions and post-
ing, are unavailable.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's skills. We recommend that you com-
plete them in order.

l Additional filesmay accompany a tutorial. Unless the tutorial provides specific instructions on where to place
these files, store them in a folder that can be access from the Mastercam2019 workstation, either with the
tutorial or in any location that you prefer.

l Youwill need an internet connection to view videos that are referenced in the tutorials. All videos can be
found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch configuration.
The tutorial provides instructions for loading the appropriate configuration file.

Mastercam Dynamic Milling Tutorial—Introduction
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DYNAMIC TOOLPATHS OVERVIEW
The following toolpaths use DynamicMotion technology:

l Dynamic Contour

l Face

l DynamicMill

l PeelMill

l Dynamic OptiRough

Each toolpath has various benefits that make themunique fromeach other and their standard counterparts.

Dynamic Toolpath Types

Dynamic Contour

The Dynamic Contour toolpath creates a familiar contour operation using dynamicmotion and specialized options
found only in dynamic toolpaths. The dynamicmotion prevents tool burial and binding in small radii corners. Addi-
tionally, you can specify howMastercammachines any material left on the walls.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview



Face

The Face toolpath, when the Style is set toDynamic, quickly cleans stock from the top of a part and creates an even
surface for future operations. You can base the toolpath on either chained geometry or on the current stock
model.

Dynamic Mill

The DynamicMill toolpathmachines pockets, leftover material, standing bosses, or cores. By setting theMachining
region strategy to Stay inside or From outside, you can create a pocket toolpath that utilizes dynamicmotion or a
facing operation that has island avoidance capabilities.

By selecting the Stay inside strategy, DynamicMill becomes a pocket toolpath that utilizes dynamicmotion. You
select a boundary, areas to avoid, and set tooling, parameters, entry method, and linking values to generate the
toolpath. Material is removed from the inside to the outside in a highly efficient manner.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview
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By selecting the From outside strategy, DynamicMill becomes a facing operation that has island avoidance cap-
abilities. Thismovement creates a toolpath that is allowed tomove outside the selectedmaterial and removes from
the outside to the inside.

By enabling Rest Material on the Stock page, the DynamicMill toolpath removesmaterial left by previous oper-
ations using dynamicmotion. The DynamicMill operation calculates howmuchmaterial to remove based on pre-
vious operations or previous roughing tools. Only unmachined areas are processed for a DynamicMill operation.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview



Peel Mill

PeelMill, with the Cutting strategy set toDynamic Peel, allows for efficient milling between selected chains. It
uses a dynamic style of motion with accelerated back feedmoveswhen the tool is not engaged inmaterial. For a
single chain, you define the width of the cut. Otherwise, the width is defined by the area between two contours.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview
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Dynamic OptiRough

The Dynamic OptiRough toolpath is currently the only 3D toolpath that usesMastercam’s DynamicMotion tech-
nology. It supports cutters capable of machining very large depths of cut. A single Dynamic OptiRough toolpath can
cut material in two directions: on stepdowns (-Z) and stepups (+Z). This bi-directional cutting strategy removes the
maximumamount of material with the minimumamount of stepdowns, significantly reducing cycle times.

Similar to DynamicMill, you can select From outside or Stay insidewhenmachining. However, instead of selecting
regions, you select machining geometry, avoidance geometry, and containment boundaries.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview



Dynamic Toolpath Selection
The Dynamic toolpaths, especially the DynamicMill toolpath, require a unique way of understanding chain selection.

Dynamic Contour does not require a closed chain to calculate a toolpath. All geometry selected will be cut by the tool
motion. PeelMill requires at least one open chain and no closed chains.

DynamicMill allows you to have evenmore control over your chaining by allowing you to select multiple kinds of
regions with one toolpath. The types of regions are listed below:

l Machining regions: Areas to be machined.

l Avoidance regions: Areas to be avoided duringmachining. Multiple avoidance regions can be selected.

l Air regions: Areas that contain nomaterial and allow the tool to travel through it whenmachining.

l Containment regions: Areas that limit toolmotion.

l Entry chain: The point where the tool enters the part or a custom chain for the entry motion to follow.

If the machining regions are open chains, you can extend the open chain to stock with the Open chain extension
to stock options. You can also close the open chains with open Air regions, connecting the start and end of the
openMachining regions. If no open chains are selected, and noOpen chain extension to stock options are
selected, they will be automatically closed with a straight line.

For more information, viewMastercam’sHelp.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview

12



13

Dynamic OptiRough, as it is the only 3D Dynamic toolpath, uses a different type of selectionmethod compared to
the other Dynamic toolpaths. When creating aDynamic OptiRough toolpath, you are brought to theModel Geo-
metry page in the Surface High Speed Toolpaths - Dynamic OptiRough dialog box. You then have the following
options:

l Machining Geometry: Geometry to be machined. You can have multiple machining groups.

l Avoidance Geometry: Geometry to be avoided. You can have multiple avoidance groups.

l For each geometry group, you can assign variable stock to leave values on its walls and floors.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview



You can then use the Toolpath Control page to set containment parameters for the Dynamic OptiRough toolpath,
which controls the tool's position around the boundary of your part.

Dynamic Milling Parameters
Several parameter options separate the Dynamic operations from their standard counterparts. These parameters
are on the Cut Parameters, Entry Motion, and Contour Wall pages.

l Micro lifts

l Entry methods

l Entry feeds/speeds

l Contour wall

l Approach distance

Micro lift options allow the tool to rise above the floor of the part for the portion of the toolpath that is not remov-
ingmaterial. Benefits of the micro lift include chip clearing and avoiding excess tool heat. The feed rate is con-
trollable for the backmove aswell.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview
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Entry methods provide several ways to enter the material for a DynamicMill toolpath. Options range froma simple
helix to amedial path with trochoidalmotion to a selected open chain. Mastercam’sHelp contains detailed inform-
ation on each of these methods.

Use Entry feeds and speeds to avoid placing toomuch load on the tool upon entry. Set a short dwell interval after
entry to allow the spindle to reach the necessary speed before beginningmaterial removal.

Contour wall parameters provide input for remaining stock and previous tool information. The values entered help
Mastercam to calculate the most efficient material removal strategy whenmachining part walls.

The Approach distance parameter allows you to add a specified incremental distance to the beginning of the
toolpath’s first cut.

Dynamic toolpaths create highly efficient motion based on selected chains and surfaces. They are part of the group
of 2D and 3D High Speed Toolpaths (HST). The dynamic toolpaths have many similarities to standard Pocket, Con-
tour, and Area Roughing toolpaths, but with the stated enhancements.

Creating and reviewing the motion of dynamic toolpaths is the best way to learn about the benefits and uses.

Mastercam Dynamic Milling Tutorial—Dynamic Toolpaths Overview
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CHAPTER 1
THE DYNAMIC MILL TOOLPATH

The DynamicMill toolpathmachines pockets, open pocket shapes and standing cores, or material left fromprevious
operations.

In this lesson, you will create two DynamicMill toolpaths. The first one will clear material around the outside of the
part. The second DynamicMill toolpath uses the previous one as a source operation for removing the remaining
material on the top of the part.

Lesson Goals

l Set up stock

l Create two DynamicMill toolpaths

l Preview region chains

l Verify the created toolpaths

Exercise 1: Opening Mastercam
1. Start Mastercamusing your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the System Configuration dialog
box.

c. Choose ...\mcamxm.config <Metric> from the Current drop-down list.

17



d. ClickOK.

Exercise 2: Setting up the stock
In this exercise, you will set up stock that will be used for the first toolpath.

1. Open the part file, DynamicMill, provided with this tutorial.

2. Save the part as DynamicMill-xxx, replacing xxxwith your initials.

3. On theMachine tab, selectMill, Default.

4. Select the LevelsManager, located in the same area as the ToolpathsManager. If it is not displayed, select
Levels on the View tab to toggle the display, or press [Alt+Z].

Before creating the stock shape, you will first create a level on which to place the stock geometry. This is a
good practice for when you need to organize part files that have thousands of lines, arcs, solids, or surfaces.

5. On the LevelsManager, select Add a new level.

A new level is added to the list and is then set as the main level.

18
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6. Double-click in the Name column of the level you have just created and rename it to Stock geometry.

This level will nowbe used to place the geometry created by the stock setup.

7. Select Stock setup in the ToolpathsManager.

TheMachine Group Properties dialog box displays.

8. On the Stock Setup tab, click Bounding box.

The Bounding Box function panel displays.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



9. Select the entire part, as shown below:

10. Press [Enter] or click End Selection to accept the selection.

11. Set the following parameters in the Bounding Box function panel:

20
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l Shape to Rectangular. This shape is better suited for this part as opposed to using Cylindrical.

l Z to 28.6. Sets the size of the box in the Z axis.

l Under Create Geometry, select Lines and arcs. This will create lines and arcs based on the stock
shape that can be used for many functions.

12. ClickOK to accept and create the boundary, and return to theMachine Group Properties dialog box.

13. ClickOK in theMachine Group Properties dialog box. The part nowdisplays with the stock boundary and
geometry.

You have now created the necessary stock and geometry to create the DynamicMill toolpaths.

14. Save your part.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



Exercise 3: Creating the first Dynamic Mill toolpath
You now create the first DynamicMill toolpath to machine the outside of the part.

1. Select Dynamic Mill from the 2D gallery on theMill Toolpaths contextual tab.

The Chain Options dialog box displays.

2. Click Select underMachining regions. Machining regions are the regions that are going to be machined.

The Chaining dialog box displays.

3. Select Cplane in the Chaining dialog box.

This option allows you to chain only entities that are parallel to the current construction plane and at the same
Z depth as the first entity you chain.

22
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4. Select the chain shown below as the machining region:

By changing the chaining selection to Cplane, you avoid selecting each line individually.

5. ClickOK in the Chaining dialog box to return to the Chain Options dialog box. 

6. Set theMachining region strategy to From outside.

From outside uses free-flowingmotion to machine features such as standing bosses or cores. This is the
strategy you want to clear the outside of the part.

7. Click Select under Avoidance regions. Avoidance regions are regions that you want to avoid duringmachin-
ing. In this case, you want to avoid the part itself and clear out the area between the stock boundary and the
part. To do this, you will need to activate another level.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



The Chaining dialog box displays.

8. Select 3D in the Chaining dialog box.

Thismode chains entities defined in the X, Y, and Z axes simultaneously.

9. Select the LevelsManager. Move the Chaining dialog box out of the way if necessary.

10. Click in the Visible column for the Part geometry level.

This will display the geometry we need to select. The geometry is a silhouette of the part. This allows you to
machine around the part and clear out the stock, but without cutting into the part.

24
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11. Select the chain shown below as an avoidance region:

12. ClickOK in the Chaining dialog box to accept the chain and return to the Chain Options dialog box.

Before you accept these chains in the Chain Options dialog box, you will first preview them to see if these
are the chains you want.

13. Right-click in the graphics window and set the view to Top (WCS).

14. In the Chain Options dialog box, click Preview chains.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



Your part displays as shown in the following image:

Mastercamdisplays your material in the red and black crosshatch, the motion region as blue, and the tool con-
tainment as yellow. By using Preview chains, you can determine if that is what you want from the toolpath
before entering any parameters.

You can change these colors by selecting the Color button. These options are also available on the Toolpath
Type page.

15. Once you are satisfied, right-click in the graphics window and select Isometric (WCS).

16. ClickOK in the Chain Options dialog box to accept these chains.

The 2D High Speed Toolpath - Dynamic Mill dialog box displays.

17. Select the Tool page.

18. Click Select library tool.

The Tool Selection dialog box displays.

26
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19. Select Filter.

The Tool List Filter dialog box displays.

20. SelectNone to remove all filters, and then select EndMill3 Bull. This ensures that you are only showing Bull
endmills tools.

Note: You can also double-click on a tool image to set the filter.

21. ClickOK in the Tool List Filter dialog box.

22. In the Tool Selection dialog box, select the END MILL WITH RADIUS - 20/R1.0 tool. If necessary, expand
the Tool Name column to view the entire tool name.

23. ClickOK in the Tool Selection dialog box to add the tool to the toolpath.

Note: You can also double-click the tool to add it to the toolpath.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



24. Select the Cut Parameters page.

25. Set the following parameters:

l Approach distance to 9.5. This adds a specified distance to the beginning of the toolpath’s first cut.

l Stepover to 50.0. Sets the distance between cutting passes in the X and Y axes.

l Minimum toolpath radius to 2.5. Mastercamuses this radius in combination with theMicro lift dis-
tance and Back feed rate parameters to calculate 3D arcmoves between cutting passes.

l Micro lift distance to 0.0. Sets the distance the tool lifts off the part on backmoves.

l Back feed rate to 0.0. Controls the speed of the back feedmovement of the tool.

l Cut order optimization toNone. Directs the toolpath to start at the most recently machinedmaterial
when cutting.

l Stock to leave on walls to 0.5. Leaves a defined amount of stock on the vertical drive geometry.

l Stock to leave on floors to 0.0. Leaves a defined amount of stock on horizontal drive geometry.

26. Select the Entry Motion page.

28
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27. Set the following parameters:

l Helix radius to 0.0. Sets the radius of the entry helix.

l Z clearance to 0.0. Sets an extra height used in the rampingmotion down froma top profile.

l Plunge angle to 0.0. Sets the angle of descent for the entry move and determines the pitch.

This toolpath does not enter down into the stock, so you do not need to set any entry parameters.

28. Select the Linking Parameters page.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



29. Set the following parameters:

l Deselect Retract. The retract distance is the height that the toolmoves up to before the next tool
pass.

l Change Top of stock andDepth to Absolute. Mastercammeasures absolute values from the origin
0,0,0.

30. Select Depth to return to the graphics window.

This determines the finalmachining depth and the lowest depth that the tool descends into the stock. In this
case, the machining depth will be in the middle of the part because DynamicMill uses the entire tool to cut.

30
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31. Select the chain shown below:

You will automatically return to the 2D High Speed Toolpath - Dynamic Mill dialog box. Your Depth should
nowbe set at -20.32.

32. ClickOK in the 2D High Speed Toolpath - Dynamic Mill dialog box to generate your toolpath.

33. The toolpath will display as shown below:

34. Save your part.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



Exercise 4: Creating the second Dynamic Mill toolpath
Youwill now create a second DynamicMill toolpath using the Rest material option.

1. In the ToolpathsManager with the DynamicMill toolpath selected, select Toggle display on selected oper-
ations.

This will hide the display of the first toolpath and keep your graphics view clean while you create another
toolpath.

2. Select Dynamic Mill from the 2D gallery on theMill Toolpaths contextual tab.

The Chain Options dialog box displays.

3. Click Select under Machining regions.

The Chaining dialog box displays.

32
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4. Select the geometry shown below as the machining region. Use the Cplane button to select the entire chain.

The selection is the same geometry used in the first DynamicMill toolpath.

5. ClickOK in the Chaining dialog box to return to the Chain Options dialog box.

6. Ensure that theMachining region strategy is set to From outside.

7. Click Select under Avoidance regions.

The Chaining dialog box displays.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



8. Select the chain shown below as an avoidance region. Set the chaining to 3D.

Youmay need to rotate the part or turn off the Solid level to select the chain.

9. ClickOK in the Chaining dialog box to accept the chain and return to the Chain Options dialog box.

10. ClickOK in the Chain Options dialog box to accept these chains.

The 2D High Speed Toolpath - Dynamic Mill dialog box displays.

11. Select the Tool page.

12. In the Tool List, select the tool that was used for the previous DynamicMill toolpath, which is END MILL WITH
RADIUS - 20/R1.0.

34
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13. Select the Stock page.

14. Select Rest material.

This enables the page and tells Mastercam to calculate the cutting passes based on the remaining stock.

15. Set the following parameters:

l Set Compute remaining stock from toOne other operation. This calculates the remaining stock
froma single operation.

l In the Operation List, select the 2D High Speed (2D Dynamic Mill) toolpath.

l Set Adjustments to remaining stock toUse as computed. This optionmakes no adjustments to the
stockmodel.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



16. Select the Cut Parameters page.

17. The parameters are the same as the previous operation’s, so ensure that your toolpathmatches the para-
meters shown below:

18. Select the Entry Motion page.

36
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19. The parameters are also the same as the previous operation’s, so ensure that your toolpathmatches the para-
meters shown below:

20. Select the Linking Parameters page.

21. Set the following parameters:

l Feed plane to 2.5. Sets the height that the tool rapids to before changing to the plunge rate to enter
the part.

l Ensure that Feed plane is set to Incremental.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



l Top of Stock to 0.0. Sets the top of the stock.

l Ensure that Top of stock andDepth are set to Absolute.

22. ClickDepth to return to the graphics window.

23. Select the arc shown below:

You will need to rotate the part to select it.

24. You will automatically return to the 2D High Speed Toolpath - Dynamic Mill dialog box. Your Depth should
be -10.16.

25. ClickOK in the 2D High Speed Toolpath - Dynamic Mill dialog box to generate your toolpath.

38
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26. The toolpath will display as shown below:

You will notice that the toolpath clears out the top of the part while avoiding the large feature that was selec-
ted as the avoidance region.

27. Save your part.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



Exercise 5: Verifying the toolpaths
Youwill now verify both DynamicMill toolpaths withMastercam Simulator. Mastercam Simulator allows you to verify
your toolpaths by using solidmodels to simulate part machining against a selected stock definition. Verify creates a
representation of the surface finish and shows collisions, if any exist. Use Verify to identify and correct program
errors before they reach the shop floor.

1. Select Toolpath Group-1 in the ToolpathsManager.

This will select both DynamicMill toolpaths.

2. Select Verify selected operations.

Mastercam Simulator displays.

40
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3. Right-click in the graphics view and select Fit and Isometric from the menu. Mastercam Simulator should
match the image shown below.

4. View the Move List, which displays all pertinent information about the toolpaths being verified. The two
DynamicMill toolpaths are able to machine the part in the time shownwith the given parameters.

5. Press Play to preview the toolpathmotion for both operations.

6. Once you are satisfied with your results, close Mastercam Simulator.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



7. Save your part file.

The DynamicMill toolpaths easily and quickly remove all of the stock on the outside and prepares the part for any
other necessary operations. In the next lesson, you will create a Face toolpath to further machine this part.

42
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CHAPTER 2
THE FACE TOOLPATH

Face toolpaths quickly clean the stock from the top of a part and create an even surface for future operations. This
toolpath can be based on chained geometry or on the current stockmodel.

For this lesson, you will create a Face toolpath on the top of the part from the DynamicMill lesson.

Lesson Goals

l Create a Face toolpath

l Preview the toolpath before it has been created

l Verify the created toolpath

Exercise 1: Creating the Face toolpath
1. Open the part file, FaceMill, provided with this tutorial or use your part file created from the DynamicMill

lesson.

2. If you are using your part from the previous lesson, select Toggle display on selected operations on the
ToolpathsManager. This will hide the two DynamicMill toolpaths and keep the graphics view clean.

3. Save the part as FaceMill-xxx, replacing xxxwith your initials.

4. Select Face from the 2D gallery on theMill Toolpaths contextual tab.

The Chaining dialog box displays.

43



5. Select Solids to activate solid selection.

6. Activate Face selection.

This allows you to select the face of a solid.

7. Select the face shown below:

8. Select OK in the Chaining dialog box.

The 2D Toolpaths - Facing dialog box displays.

44
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9. Select the Tool page.

10. Select the END MILL WITH RADIUS - 20 / R 1.0, which was used in the previous two DynamicMill toolpaths.
If necessary, expand the Tool Name column to see the entire tool name.

11. Select the Cut Parameters page.

12. Set the following parameters:

Mastercam Dynamic Milling Tutorial—2: The Face Toolpath



l Style toDynamic. Creates a smooth controlledmotion that cuts from the outside to the inside, main-
taining a constant load on the tool withminimal entries and exits.

l Stock to leave on floors to 0.0. Sets the amount of stock to leave on the floors duringmachining.

l Maximum stepover to 50.0. Sets the distance between adjacent passes in the toolpath.

13. Select the Linking Parameters page.

14. Set the following parameters:

l Deselect Retract. Sets the height that the toolmoves up to before the next tool pass.

l Set Feed plane to 2.5. Sets the height that the tool rapids before changing to the plunge rate to enter
the part.

l Set Top of stock to 0.2. Sets the height of the material in the Z axis.

Before clickingOK, you will first preview the toolpath. Previewing toolpaths allows you to view the toolpath
before generating it so that you canmake adjustments as necessary.

46

Mastercam Dynamic Milling Tutorial—2: The Face Toolpath



47

15. Select Preview toolpath on the 2D Toolpaths - Facing dialog box.

16. The toolpath will display on the part as shown below:

17. ClickOK in the 2D Toolpaths - Facing dialog box to close and generate the toolpath.

18. Save your part.

Mastercam Dynamic Milling Tutorial—2: The Face Toolpath



Exercise 2: Verifying the toolpaths
You now verify the two DynamicMill toolpaths created from the previous chapter and the Face toolpath together.

1. Select Toolpath Group-1 in the ToolpathsManager.

This selects both DynamicMill toolpaths and the Facing toolpath.

2. Select Verify selected operations.

Mastercam Simulator displays.

48
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3. Right-click in the graphics view and select Fit and Isometric from the menu. Mastercam Simulator should
match the image shown below.

4. Press Play to preview the toolpathmotion for the toolpaths.

There will be material remaining on the top face of the part. That is to be expected.

5. View the Move List, which displays all pertinent information about the toolpaths being verified. The three
DynamicMill toolpaths are able to machine the part in the time shownwith the given parameters.

Mastercam Dynamic Milling Tutorial—2: The Face Toolpath



6. Select Color Loop, By Operation on the Verify tab to help distinguish between each toolpath.

Mastercam Simulator color-codes each toolpath so that you can distinguish where each toolpath cuts the part.
The colors on the part correspond to those on the time bar.

7. Once you are satisfied with your results, close Mastercam Simulator.

8. Save your part file.

Using the DynamicMill toolpaths and the Face toolpath, you have quickly cleared the part to prepare it for finishing
operations. In the next lesson, you create two Dynamic Contour toolpaths.

50
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CHAPTER 3
THE DYNAMIC CONTOUR TOOLPATH

Mastercam’s Dynamic Contour toolpathmillsmaterial off walls and supports closed or open chains. Compared to its
standard counterpart, the Dynamic Contour toolpath providesmuchmore efficient cutting by using the entire flute
of the tool.

In this lesson, you create aDynamic Contour toolpath to clear around the walls of the part.

Lesson Goals

l Create two Dynamic Contour toolpaths

l Analyze the toolpaths

l Verify the created toolpaths

Exercise 1: Setting up the stock
1. Open the part file, DynamicContour, provided with this tutorial.

2. Save the part as DynamicContour-xxx, replacing xxxwith your initials.

3. On theMachine tab, selectMill, Default.

4. Select Stock setup from the ToolpathsManager.

TheMachine Group Properties dialog box displays.

5. Select Bounding box on the Stock Setup tab.
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The Bounding Box function panel displays.

6. Select the part and press [Enter] or select End Selection.

7. Set Z to 13.7. This adds a small amount of stock to the Z height of the stock boundary.

8. ClickOK to create the boundary.

9. ClickOK to accept the stock setup.
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Exercise 2: Creating the first Dynamic Contour toolpath
1. Select Dynamic Contour from the 2D gallery on theMill Toolpaths contextual tab.

The Chain Options dialog box displays.

2. Click Select under Machining regions.

The Chaining dialog box displays.

3. Select Solids to activate solid chainingmode.

In Solid chainingmode, the Chaining dialog box gives you options to manage the chaining of solid entities.

4. Select Loop if it is not already selected. Deselect Face if it is selected.

This allows you to select a closed chain on a reference face.
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5. Select the edge shown below. Youmay need to zoom in.

The Pick Reference Face dialog box displays. This dialog box allows you to cycle through possible reference
faces on a solid until you reach the one you want.

6. Ensure that the face shown below is selected:

Select Other face if necessary to cycle through the possible reference faces.
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7. ClickOK to return to the Chaining dialog box. The chain will be displayed as shown below:

Reverse the chain if necessary.

8. ClickOK in the Chaining dialog box to accept the chains and return to the Chain Options dialog box.

9. ClickOK in the Chain Options dialog box.

The 2D High Speed Toolpath - Dynamic Contour dialog box displays.

10. Select the Tool page.

11. Click Select library tool.

The Tool Selection dialog box displays.

12. Click Filter.

The Tool List Filter dialog box displays.

13. Set the Tool Type filter toNone.
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14. Select the Endmill1 Flat filter, and deselect any other filter. This ensures that you are only selecting flat end
mill tools.

15. ClickOK in the Tool List Filter dialog box.

16. In the Tool Selection dialog box, select the FLAT END MILL - 4 tool.

17. ClickOK in the Tool Selection dialog box.

18. Select the Cut Parameters page.
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19. Set the following parameters:

l Compensation direction to Left. Offsets the tool to the right or left of the toolpath.

l Approach distance to 5.0. Adds a specified incremental distance to the beginning of the toolpath’s
first cut.

l First pass offset to 1.0. Offsets the machining region to ensure the tool does not engage toomuch
material during the first pass of the toolpath when entering stock from the outside.

l Stepover to 15.0. Sets the distance between cutting passes in the X and Y axes.

l Minimum toolpath radius to 5.0. Sets the minimum toolpath radius for the operation.

l Set Stock to leave on walls and Stock to leave on floors to 0.0. You are not leaving any stock on the
vertical and horizontal surfaces.

20. Select the Contour Wall page.

21. Set the following parameters:
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l Radius of tool that shaped the stock to 8.0.

l Minimum toolpath radius that shaped the stock to 1.0.

l Stock thickness to 0.025.

Both parameters help define the shape of the stock removed by the toolpath. Mastercam calculates the stock
to remove along the contour wall by using these parameters.

22. Select the Linking Parameters page.

23. Set the following parameters:

l Retract, Top of stock, andDepth to Absolute. Thismeasures absolute values from the origin 0,0,0.

l Retract to 15.0. Sets the height that the toolmoves up before the next tool pass.

l Feed plane to 3.0. Sets the height that the tool rapids to before changing to the plunge rate to enter
the part.

l Top of stock to 13.7. Sets the height of the material in the Z axis.
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24. Select Depth. You return to the graphics window.

Depth determines the finalmachining depth and the lowest depth that the tool descends into stock. You will
select an edge for this toolpath.

25. Select the edge shown below:

You automatically return to the Linking Parameters page. Your Depth should nowbe 9.525.

26. ClickOK in the 2D High Speed Toolpath - Dynamic Contour dialog box to accept and generate your
toolpath.

27. Your toolpath displays as shown below:

28. Save your part.
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Exercise 3: Creating the second Dynamic Contour toolpath
1. Select Dynamic Contour from the 2D gallery on theMill Toolpaths contextual tab.

The Chain Options dialog box displays.

2. Click Select underMachining regions.

The Chaining dialog box displays.

3. Activate Solids selection if necessary.

4. Set the chaining to Linked edges.

This allows you to select contiguous chaining of edges.
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5. Zoom in using the mouse wheel and select the edge shown below.

Mastercam Dynamic Milling Tutorial—3: The Dynamic Contour Toolpath



6. The chain will display as shown below. Reverse the direction if needed, using Reverse on the Chaining dialog
box.

7. Use the Next control in the Chaining dialog box to select the chain shown below.

8. In the Chaining dialog box, click End chain.

This ends the chain so that you can start a newone that is not linked to the previous chain.
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9. Using the controls in the Chaining dialog box, select the second partial chain shown below:

10. ClickOK in the Chaining dialog box and return to the Chain Options dialog box.

11. ClickOK in the Chain Options dialog box.

The 2D High Speed Toolpath - Dynamic Contour dialog box displays.

12. Select the Tool page.

13. Click Select library tool.

The Tool Selection dialog box displays.

14. Select the FLAT END MILL - 8 tool.

15. ClickOK in the Tool Selection dialog box.

16. Select the Cut Parameters page.
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17. Set the following parameters:

l Approach distance to 12.0.

l First pass offset to 3.0.

18. Select the Contour Wall page.

19. Set Radius of tool that shaped the stock to 10.0.

20. Select the Linking Parameters page.
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21. Set the following parameters:

l Retract to 16.0 and Absolute.

l Feed plane to 3.0 and Incremental. Incremental values are relative to other parameters or chained
geometry.

l Top of stock to 9.525 and Absolute.

l Depth to 0.0 and Incremental.
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22. ClickOK to generate the toolpath.

The toolpath will display as shown below:

Exercise 4: Analyzing the toolpaths
You now analyze the toolpath. Analyze Toolpath allows you to view toolpath properties, such as coordinates, dir-
ection, operation number, and other information by hovering over the toolpath.

1. Select Analyze Toolpath from the Home tab.
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2. Hover over the first toolpath:

Analyze Toolpath informs you of the operation number, the feedmove, spindle speed, G1 and the line
length, and the coolant code. It also displays the start and end of the toolpath and of the section you are hov-
ering over. If there ismore than one toolpath displayed at the time, then toolpaths other than the one you
are hovering over are dimmed.

3. Continue hovering over areas of both toolpaths. Once you are satisfied, press [Esc] or Cancel out of the func-
tion.

Exercise 5: Verifying the toolpaths
Youwill now verify both toolpaths.

1. Select Toolpath Group-1 in the ToolpathsManager.

This selects both toolpaths so that they can be verified at the same time.
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2. Select Verify selected operations.

Mastercam Simulator displays.

3. Right-click in the graphics view and select Fit and Isometric, if necessary, so that the display matches the
image below:

4. View the Move List, which displays all pertinent information about the toolpaths being verified. By using two
Dynamic Contour toolpaths, the totalmachining time is approximately one minute.
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5. Press Play to preview the toolpathmotion for both operations.

6. Once you are satisfied with your results, close Mastercam Simulator.

7. Save your part file.

In the next lesson you will create three PeelMill toolpaths.
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CHAPTER 4
THE PEEL MILL TOOLPATH

The PeelMill toolpath, with the Cutting strategy set to Dynamic Peel, allows for efficient milling between selected
chains. It uses a dynamic style of motion with accelerated back feedmoveswhen the tool is not engaged inmaterial.

In this lesson you will create one PeelMill toolpath, copy it twice, andmake edits.

Lesson Goals

l Create a PeelMill toolpath

l Copy and paste the toolpath

l Make edits to the copied toolpaths

l Verify the created toolpaths

Exercise 1: Setting up the stock
1. Open the part file, PeelMill, provided with this tutorial.

2. Save the part as PeelMill-xxx, replacing xxxwith your initials.

3. On theMachine tab, selectMill, Default.

4. Select Stock setup from the ToolpathsManager.

TheMachine Group Properties dialog box displays.

5. Select Bounding box.
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The Bounding Box function panel displays.

6. Select the part and press [Enter] or click End Selection.

For this part, no geometry needs to be created. The bounding box will be accepted as it is.

7. ClickOK to create the boundary.

8. ClickOK to accept the stock setup.

Exercise 2: Creating the first Peel Mill toolpath
1. Select Peel Mill from the 2D gallery on theMill Toolpaths contextual tab.

The Chaining dialog box displays.

72

Mastercam Dynamic Milling Tutorial—4: The Peel Mill Toolpath



73

2. Activate Solids selection from the Chaining dialog box.

3. Select Edge if it has not already been selected. Deselect Face if it is selected.

This allows you to select the solid edges of amodel.

4. Select Translucency on the View tab.

This toggles the translucency of the current model and will help with selection for this first toolpath.
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5. Select the two edges shown below. Use Reverse if necessary to ensure both chains go in the same direction.

6. Toggle Translucency to off.

7. ClickOK in the Chaining dialog box.

The 2D High Speed Toolpath - Peel Mill dialog box displays.

8. Select the Tool page.

9. Click Select library tool.

The Tool Selection dialog box displays.
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10. Click Filter.

The Tool List Filter dialog box displays.

11. Ensure that tools are filtered to Endmill1 Flat.

12. ClickOK in the Tool List Filter dialog box to accept the filter and return to the Tool Selection dialog box.

13. Select the FLAT END MILL - 12 tool.

14. ClickOK to add that tool and exit the Tool Selection dialog box.

15. Select the Cut Parameters page.
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16. Set the following parameters:

l Stepover to 20.0%.

l Minimum toolpath radius to 5.0%.

l Select Extend Exit and set Additional exit distance to 3.0. This adjusts the final tool engagement with
the material.

17. Select the Linking Parameters page.

18. Set the following parameters:

l Set Retract to 40.0.

l Set Feed plane to 40.0.
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19. Click Top of stock to return to the graphics window to select the top of the stock of the part.

20. Select the point shown below:

You automatically return to the Linking Parameters page. Top of stockwill be set at 38.1.

21. ClickOK in the 2D High Speed Toolpaths - Peel Mill dialog box to generate the toolpath.

The toolpath will display as shown below:

22. Save your file.
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Exercise 3: Copying the Peel Mill toolpath
In this exercise, you copy the PeelMill operation twice in the ToolpathsManager.

1. Right-click on the 2D High Speed (2D Dynamic Peel Mill) toolpath and drag and drop it below the red insert
arrow.

2. Select Copy after from the right-click menu that displays.

The toolpath is copied below the original. There are now two PeelMill toolpaths in the ToolpathsManager.

3. Click and drag the red arrow to position it below the copied operation.

4. Copy the toolpath once more. You will nowhave three PeelMill toolpaths in the ToolpathsManager.

Copying and pasting toolpaths is helpful when you have to do similar cuts on the same part. In the case of
these toolpaths, you will have to re-chain the geometry.

5. Click and drag the red arrowbelow the third toolpath.

6. Save your file.
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Exercise 4: Re-chaining the copied Peel Mill operations
In this exercise, you will re-chain the geometry for the PeelMill toolpaths that were copied.

1. Select Geometry under the second PeelMill toolpath.

The Chain Manager dialog box displays.

2. Right-click in the Chain Manager dialog box and select Rechain all.

The Chaining dialog box displays.

3. Select the chains shown below. Ensure that the chains are both going in the same direction. Youmay need to
rotate the part or select Translucency on the View tab to select them.
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By doing this, you only need to select the chains for the toolpath without having to go through creating the
entire toolpath again.

4. ClickOK in the Chaining dialog box and return to the Chain Manager dialog box.

5. ClickOK in the Chain Manager dialog box.

Before regenerating the toolpath, you will re-chain the third operation.

6. Select Geometry under the third PeelMill toolpath.

The Chain Manager dialog box displays.

7. Right-click in the Chain Manager dialog box and select Rechain all.

The Chaining dialog box displays.

8. Select the chains shown below. Ensure that the chains are both going in the same direction.

9. ClickOK in the Chaining dialog box and return to the Chain Manager dialog box.

10. ClickOK in the Chain Manager dialog box.
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11. Select Regenerate all dirty operations in the ToolpathsManager.

The second and third PeelMill toolpaths regenerate using the newly selected chains. All three PeelMill
toolpaths will display as shown below:

12. Save your file.
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Exercise 5: Verifying the toolpaths
In this exercise, you will verify all three PeelMill operations together.

1. Select Toolpath Group-1 in the ToolpathsManager to select all of the toolpaths.

2. Select Verify selected operations.

Mastercam Simulator displays.

3. Right-click in the graphics view and select Fit and Isometric, if necessary, so that the display matches the
image below:
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4. View the Move List to view the total run time of the toolpaths.

5. Press Play to preview the toolpathmotion for the operations.

6. Once you are satisfied with your results, close Mastercam Simulator.

7. Save your part file.

When creating similar toolpaths, copying and pasting saves time. In the next lesson you create two Dynamic
OptiRough operations and a stockmodel operation.
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CHAPTER 5
THE DYNAMIC OPTIROUGH TOOLPATH

The 3D surface high speed Dynamic OptiRough toolpath uses an aggressive, fast, intelligent roughing algorithm
based onMastercam’s 2D high speed dynamicmillingmotion.

In this lesson, you will create two Dynamic OptiRough toolpaths using different cutting strategies, and a stockmodel
operation in order to rough out the part.

Note: Youmust have a 3D license to complete this Dynamic OptiRough lesson.

Lesson Goals

l Set up the stock

l Create two Dynamic OptiRough toolpaths

l Create a stockmodel operation

Exercise 1: Setting up the stock
In this exercise, you will create the stockmodel that will be used for the first Dynamic OptiRough toolpath.

1. Open the part file, DynamicOptiRough, provided with this tutorial.

2. Save the part as DynamicOptiRough-xxx, replacing xxxwith your initials.

3. On theMachine tab, selectMill, Default.

4. Select the LevelsManager, located in the same area as the ToolpathsManager. If it is not displayed, select
Levels from the View tab to toggle the display.

Before creating the stock shape, you will first create a level on which to place the stock geometry. This is a
good practice for when you need to organize part files that have thousands of lines, arcs, solids, or surfaces.
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5. On the LevelsManager, select Add a new level.

A new level is added to the list and is then set as the main level.

6. Double-click in the Name column of the level you have just created and rename it to Stock geometry.

This level will nowbe used to place the geometry created by the stock setup.

7. Select Stock setup from the ToolpathsManager.

TheMachine Group Properties dialog box displays.

8. Select Bounding box.

The Bounding Box function panel displays.
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9. Window select all entities to create a bounding box around the entire part.

10. Press [Enter] to accept your selection.

11. Set the following parameters in the Bounding Box function panel:

l Set Shape to Cylindrical.

l Set Radius to 150.
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l Set Axis to Z.

l Set Height to 102.00. This will add a small amount of stock at the top of the part.

12. In the Create Geometry group, select Lines and arcs.

This will create lines and arcs based on the stock boundary. You will then use this geometry to contain the first
Dynamic OptiRough toolpath.

13. ClickOK to create the boundary.

14. ClickOK in theMachine Group Properties dialog box to accept the stock setup.

The stockmodel displays as a dashed outline in red. The geometry that was created with the Bounding Box
also displays.
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Exercise 2: Creating the first Dynamic OptiRough toolpath
In this exercise, you create the first Dynamic OptiRough toolpath that uses this stock boundary.

1. Select OptiRough from the 3D gallery on theMill Toolpaths contextual tab.

TheModel Geometry page of the Surface High Speed Toolpaths - Dynamic OptiRough dialog box dis-
plays.

2. Select theMachining group, and then click Select entities under Machining Geometry.
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3. Use window select or any applicable keyboard shortcuts to select the part body as the drive surfaces. This
includes the blue caps, as shown below.

4. Press [Enter] or click End Selection to accept these surfaces.

You return to theModel Geometry page.

5. Since you are creating a roughing toolpath, enter the following stock to leave amounts on the wall and floor.
Double-click to activate the field.

l Enter 0.3 inWall Stock

l Enter 0.3 in Floor Stock

6. Select the Toolpath Control page.
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7. Click the Boundary chains selection arrow.

This returns you to the graphics window to select one or more closed chains of curves to limit the toolmotion.

8. In the graphics window, select the geometry at the top of the stock boundary. Youmay need to change to
Wireframemode in the Chaining dialog box.

9. ClickOK to return to the Toolpath Control page of the Surface High Speed Toolpaths - Dynamic
OptiRough dialog box.

10. Set the containment boundary Strategy to From outside.

From outside sets the toolpath to machine fromoutside the containment boundary moving in. This strategy
is best used for machining cores.
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11. Select the Tool page.

12. Click the Select library tool button.

The Tool Selection dialog box displays.

13. Select Filter.

The Tool List Filter dialog box displays.

14. Set the Tool Type filter toNone.

15. Select the Endmill3 Bull filter, and deselect any other tool filter. This ensures that you are only selecting bull
endmill tools.

16. ClickOK in the Tool List Filter dialog box.

You return to the Tool Selection dialog box.

17. In the Tool Selection dialog box, select the END MILL WITH RADIUS - 20/R2.0 tool.

18. ClickOK in the Tool Selection dialog box to add the tool to the toolpath.

19. Select the Cut Parameters page.
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20. Set the following parameters:

l Optimize stepups to By pocket. Mastercam first machines all stepdowns, moving frompocket to
pocket. After all stepdowns on a Z-level are machined to completion, Mastercammachines the stepups
by next closest, in the safest cut order.

l Stepover to 30.0%. Sets the distance between cutting passes in the X and Y axes.

l Stepdown to 150.0%. Determines the Z spacing between adjacent cutting passes.

l Select the Stepup checkbox and enter 15.0. Mastercam calculates and adds stepup cutting passes (+Z)
to the toolpath.

l Minimum toolpath radius to 10.0. Sets the minimum toolpath radius to create in the operation.

l Micro lift distance to 0.0.

l Back feed rate to 100.0. Controls the speed of the backfeedmovement of the tool.

l % of tool diameter to 10000.0.

21. Select the Transitions page.
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22. Set the following parameters:

l Helix radius to 9.0. Sets the radius of the entry helix.

l Skip pockets smaller than to 66.0. Specifies aminimumpocket size that Mastercamwill create a cut-
ting pass for. This helps with problemswhere Mastercam thinks that a pocket is large enough to accom-
modate the tool, but the entry move is so compressed the tool is effectively plunging into the part.

23. Select the Linking Parameters page.
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24. Set the following parameters:

l Set the Retract Method drop-down toMinimum Distance. Creates high-speed loops into and out of
each retract move.

l Select Output feed move and enter 12500.0. Outputs the rapidmove between passes as a feed rate
move instead of a rapidmove. This helps when the tool needs to make many irregular moves per pass
to jump between different areas of the part.

l Set Ramp height to 1.0. Sets the height of the helix whenmoving into a new region.

25. ClickOK to close the Surface High Speed Toolpaths - Dynamic OptiRough dialog box and generate your
toolpath.
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26. Your toolpath should display as follows:

27. Save your part file.

Exercise 3: Creating the Stock Model operation
You now create a Stock Model operation that uses the previous operation as its source. This stockmodel will be used
in the second Dynamic OptiRough toolpath to remove any remaining stock.

1. On the ToolpathsManager, select Only display selected toolpaths.

This will only display the toolpath you have selected. It will also clean up the graphics viewwhenmakingmodi-
fications to the part or creating another toolpath.

2. Select Stock Model on theMill Toolpaths contextual tab.
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The Stock model dialog box displays.

3. Name the stock operationOP1 Stock.

Naming your stockmodel based onwhich operation it is using is helpful, especially when you have a part with
multiple stockmodel operations.

4. Set Color to 128.

This will help differentiate the stockmodel from the solid or surface model.

5. Select Stock Setup.

Stock Setup copies the values defined in theMachine Group Properties dialog box to corresponding fields
in the Stock Definition page. The values are not associative.

6. Select the Source Operations page.

7. Select the Surface High Speed (Dynamic OptiRough) toolpath as the source operation.

The stockmodel is generated by running the selected operation against the parameters on the Stock Defin-
ition page.

8. ClickOK to create the stockmodel operation. Thismay take some time to calculate.
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9. Your stockmodel displays as shown below:

10. Turn off Only display selected toolpaths from the ToolpathsManager.

11. Save your part.

Exercise 4: Creating the second Dynamic OptiRough toolpath
You now create the second Dynamic OptiRough toolpath that uses the stockmodel you created in the previous exer-
cise.

1. Select Toolpath Group-1 in the ToolpathsManager.

2. Select Toggle display on selected operations. This hides all selected toolpaths to keep the graphics window
clean.
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3. Select OptiRough from the 3D gallery on theMill Toolpaths contextual tab.

TheModel Geometry page of the Surface High Speed Toolpaths - Dynamic OptiRough dialog box dis-
plays.

4. Select theMachining group, and then click Select entities under Machining Geometry.

5. In the LevelsManager, turn off the display of the Caps level and turn on the Stock geometry level to make it
easier to select the drive surfaces.

6. Select all but the blue caps as the drive surfaces shown below.

7. Press [Enter] or click End Selection to accept these surfaces.

The Surface High Speed Toolpaths - Dynamic OptiRough dialog box displays.
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8. Select the Toolpath Control page.

9. Click the selection arrow for Boundary chains to return to the graphics window.

10. In the graphics window, select the geometry at the top of the stock boundary.

11. ClickOK in the Chaining dialog box to return to the Toolpath Control page.

12. Set the following parameters to control the tool’s position around the boundary of your part.
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l Set Compensate to toOutside. This sets the outer edge of the tool to be bound to the containment
boundary.

l Set Offset distance to 10.0. This option adjusts the inside or outside tool containment boundary.

13. Select the Tool page.

14. Click Select library tool.

15. In the Tool Selection dialog box, select the END MILL WITH RADIUS - 10/R1.0 tool.

16. ClickOK to add the tool to the toolpath.

17. Select the Stock page.

18. Select Rest material.

When you enable this page, Mastercam calculates the cutting passes based on the remaining stock.
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19. Set the following parameters:

l Set Compute remaining stock from toOne other operation.

l In the Operation List, select Stock Model - OP1 Stock.

l Set Adjustments to remaining stock to Ignore small cusps.

l Set Distance to 1.0. This option is used in conjunction with Ignore small cusps. Mastercamwill output
cuts that engage large amounts of material.

20. Select the Cut Parameters page.
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21. Set the following parameters:

l Optimize stepups toNext closest. Mastercammoves to the closest cut from its last position on the
previous cut.

l Stepover to 30.0%.

l Stepdown to 150.0%.

l Stepup to 30.0%.

l Minimum toolpath radius to 10.0%.

l Motion > Gap size, retract toWhen avoiding a boundary. Adds retracts to avoid intersecting
boundaries (a gouge boundary, or a boundary of material yet to be milled).

22. Select the Transitions page.
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23. Set the Helix radius to 5.5.

24. ClickOK to create and generate the Dynamic OptiRough toolpath.

25. Select Toggle display on selected operations to display toolpaths again, and select the second Dynamic
OptiRough toolpath to view the newly created toolpath.

26. Save your part file.
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Exercise 5: Verifying the stock model and toolpaths
In this exercise, you use Mastercam Simulator to verify your toolpaths and stockmodel. Verifying your toolpaths
allows you to use solidmodels to simulate part machining against the selected stock definition.

1. Select Toolpath Group-1 in the ToolpathsManager.

2. Select Verify selected operations in the ToolpathsManager.

Mastercam Simulator displays.
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3. If necessary, right-click in the graphics window and change the view to Isometric and Fit the part to the
screen so that it matches the image shown below.

4. Click the Play button or press [R] to verify the toolpaths.
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5. View the Move List to view the total run time of the toolpaths.

6. Once you are satisfied with the verification, close Mastercam Simulator.

7. Save your part.
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CONCLUSION
Congratulations! You have completed the Mastercam Dynamic Milling Tutorial! Now that you have mastered the skills
in this tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being constantly developed, and we
will addmore as we complete them. Visit our website, or select Help, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercamexperience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software
in the Documentation folder of your Mastercam2019 installation.

l Mastercam Help—AccessMastercamHelp by selectingHelp, Contents fromMastercam's File tab or by press-
ing [Alt+H] on your keyboard.

l Mastercam Reseller—Your localMastercamReseller can help withmost questions about Mastercam.

l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is
openMonday through Friday from8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials fromMastercam's File tab to
see the latest publications.

l Mastercam University—MastercamUniversity, an affordable online learning platform, gives you 24/7 access to
Mastercam trainingmaterials. Take advantage of more than 180 videos to master skills at your own pace and
help prepare for MastercamCertification. For more information onMastercamUniversity, please contact
your AuthorizedMastercamReseller, visit www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find awealth of information at www.mastercam.com. For tech tips and the
latest Mastercamnews, follow us on Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). Visit our YouTube channel to see
Mastercam in action (www.youtube.com/user/MastercamCadCam)! Registered users can search for inform-
ation or ask questions on the MastercamWeb forum, forum.mastercam.com, or use the knowledgebase at
kb.mastercam.com.

Contact Us

For questions about this or other Mastercamdocumentation, contact the Technical Documentation department by
email at techdocs@mastercam.com.
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